After you install Macromedia Breeze Presenter, you can access the application from within Microsoft PowerPoint. You can access all Breeze Presenter authoring functions in PowerPoint by using the Breeze menu.

**About the Breeze Presenter workspace**

Macromedia designed Breeze Presenter for efficiency and ease of use. Breeze Presenter has the following two components that work together to help authors create and deliver high-quality content for users:

- **Breeze Presenter** enables authors to create content.
- **Breeze Presenter viewer** allows users to view and interact with converted Breeze Presenter presentations.
For content authors, all Breeze Presenter features are accessible from the Breeze menu in PowerPoint.

All of the options for designing a presentation are located in the Breeze menu in PowerPoint.

Planning Breeze Presenter presentations

Creating presentations with Breeze Presenter is fast and easy if you follow these basic steps.

1. Plan your presentation using storyboards, scripts, or whatever organizational materials are appropriate.
2. Open an existing PowerPoint presentation or create a new presentation.
3. In PowerPoint, from the Breeze menu, you can add audio narration, quizzes, presenter information, and other options to your presentation. You can include attachments such as web pages or documents and you can customize themes (the look and feel of the presentation viewer) for each presentation.
4. On your local computer, follow the steps for “Previewing a presentation” on page 14.
5. Publish the presentation to a Breeze server. You can also burn the presentation to a CD or upload the presentation to the web using a third-party FTP software program.

Determining presentation goals

No matter what kind of presentation you want to create, it is helpful to do some planning before you start. Consider first what you want the user to learn, achieve, and so on as a result of viewing your presentation. Defining this goal from the beginning lets you create a comprehensive plan for success. After you have defined the goal of the presentation, you can use an existing PowerPoint presentation and enhance it with the most effective Breeze Presenter options.
When planning, you should consider adding the following elements to your presentation:

**Title slides**  Title slides are usually the first or second slide in a presentation and state the subject of the content.

**Presenter information**  Include the name, title, photo, contact information, and a short biography of the presenter or presenters.

**Custom logos**  Add a company or organization logo to brand and personalize a presentation.

**Copyright information**  Depending on the length of the information, include copyright text on the first or last slide in a presentation, or add a separate slide containing only copyright information.

**Opening and closing slides**  Create a distinctive start and finish to clearly show users the beginning, middle, and end of the presentation. You can use the same opening and closing slide across a series of presentations for a unifying professional look.

**Section divider slides**  Use slides that delineate sections within a presentation. This is especially useful in long presentations.

**Sounds**  Voice-over narration, music, or sound effects can add a new dimension to presentations.

**Quizzing**  Let users interact with the presentation, while you track their learning progress or obtain information (surveys).

**Attachments**  Add existing information as supporting content for presentations. You can include documents, spreadsheets, links to web pages, and images as attachments.

### Breeze Presenter best practices

Macromedia recommends using these best practices to create a great online presentation:

- Design your online presentation based on the bandwidth capabilities of your audience. If your audience has fast, broadband connections, you can create a graphic-intensive presentation that includes many animations. However, if your audience has slower connection speeds, you should use graphic images that ensure your audience has a good viewing experience.

- It helps to create a written script before recording audio for your presentation. Speaking into a microphone can be more difficult than giving a presentation to a live audience. To ensure a smooth delivery that covers all of your important points, consider creating a script for the entire presentation before recording audio for it. (If you have slide notes written in PowerPoint, you can easily import them into Breeze Presenter to use as a script or as the basis of a script.)

- Add animations enhances the overall presentation. Breeze Presenter supports PowerPoint animations so that you can create powerful, animated, multimedia presentations. Animations add impact to your message and improve the user's overall viewing experience.

- Preview the presentation by publishing it locally before publishing to Breeze. This lets you view the converted presentation to be sure that it meets your requirements.

- Create slide titles to give users easy access to any slide. Check that titles appear in the PowerPoint outline for all slides, including graphic-only slides, before publishing your presentation.
Creating Breeze Presenter presentations

Breeze Presenter presentations are always based on PowerPoint presentations. To create a new presentation, you open an existing PowerPoint presentation (or create a new one) and then add all of the features available in Breeze Presenter. For more information about how to add these features, see the appropriate chapter.

The following procedure describes the general steps for creating a simple Breeze Presenter presentation.

To create a Breeze Presenter presentation:
1. In PowerPoint, open a presentation (PPT) file or create a new one by selecting File menu > New.
2. From the Breeze menu, select the Breeze Presenter features you want to add to your presentation.
   You are not required to make any changes before publishing, but adding Breeze Presenter features such as audio narration, SWF files, quizzes, attachments, and a theme will enhance your presentation and give you the opportunity to experiment with the functionality available in Breeze Presenter.
3. Preview the presentation by publishing it locally (to your computer). (For instructions on how to do this, see the next section).
4. If necessary after previewing, return to step 2 and make any changes required.
5. When you are finished, publish the presentation to a Breeze server. For more information, see “Publishing to a Macromedia Breeze server” on page 86.

Previewing a presentation

If you want to check your work, you can preview presentations at any time by publishing to your local computer. This is a fast way to see how the presentation will look to users.

When you preview a presentation, it appears in your default web browser. All of the functionality in the presentation, such as audio and quizzes, works exactly the way it will in the Breeze Presenter viewer. The presentation appears with all of the theme settings and colors you have chosen.

To preview a presentation by publishing to your local computer:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Publish.
3. Select My Computer on the left side.
4. Click Publish. When you publish, the following actions take place:

- By default, a new folder with the same name as the presentation is created and placed in your My Documents\My Breeze Presentations folder. The new folder contains all of the presentation files, and any audio, video, image, and attachment files that are part of the presentation.
- Theme and presenter information are stored in your Local Settings folder (frequently located at C:\Documents and Settings\user name).

5. When the conversion is finished, click View Output.

If you click View Output when the conversion is finished, the presentation appears in your default web browser.
CHAPTER 2
Editing Breeze Presenter Presentations

After you have created a presentation, you can use Breeze Presenter to edit your work quite easily. Normally, you will probably create a presentation, preview the presentation locally, edit the presentation to make it just right, and publish the presentation to Breeze.

This chapter contains the following topics:

• “Changing the presentation title” on page 17
• “Adding a presentation summary” on page 17
• “Changing slide properties” on page 18
• “Adding and editing presenters” on page 21
• “Adding attachments to presentations” on page 23
• “Using animation, image, and Flash (SWF) files” on page 26

Changing the presentation title

You can change the presentation title at any time. The title appears in the Breeze Presenter viewer.

To change the presentation title:

1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Presentation Settings.
3. Select the Settings tab.
4. In the Title text box, enter a new name for the presentation.
5. Click OK.

Adding a presentation summary

A presentation summary is usually a short description of the presentation contents. Adding a summary is optional and is a useful organizing tool for presentation authors. The summary appears only in the presentation settings of the presentation; it does not appear in the published presentation and is not visible to users.

Note: The presentation summary does appear in Breeze Server after a presentation has been published to Breeze. Presentation authors can search summaries and see the summary when viewing content information.
To add a presentation summary:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Presentation Settings.
3. Select the Settings tab.
4. In the Summary text box, enter a description of the presentation contents.
5. Click OK.

Changing slide properties

You can easily view and change the properties of any slide in a presentation at any time. This can help you make changes to a slide or group of slides quickly and easily. For example, if you have assigned a presenter to all of the slides, but there are a few slides where another presenter is providing slides or audio narration, you can use slide properties to assign the new presenter to the correct slides.

The following sections describe the slide properties you can change:

- Setting a navigation name
- Setting slide advance behavior
- Setting the presenter for a slide
- Setting a Go to Slide option
- Adding video to a slide

Note: You can select multiple slides to easily update the Presenter and Advance by User settings. Simply select a slide, hold down Shift or Control, and select additional slides. (The Navigation name, Go to Slide, or Video properties cannot be changed this way.)

Using slide properties, you can change options for individual slides or a group of slides.
Viewing slide properties for all slides in a presentation

You can view a short description of all slides in a presentation in one central location. For example, you can see what presenters are associated with each slide, if navigation names have been assigned, and if any slides must be advanced by the user.

To view slide properties for all slides:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Slide Properties.
   The Slide Properties dialog box appears.
3. Use the scroll bar on the right side to view all of the slides in the presentation.

Setting a navigation name

You can set a navigation name for a slide that is different than the slide title. A clear and descriptive navigation name can make it easier for users to navigate through the published presentation. The navigation name appears in the sidebar (Outline and Thumb panes) in the published presentation.

For more information about the sidebar and panes, see Chapter 5, “Designing the Presentation Experience,” on page 69.

A navigation name can be useful if your slide titles are long or if you want to display a more descriptive name than the slide title in the final presentation for users. For example, the first slide in the presentation might have the generic slide title “Introduction,” but you can assign a navigation name such as “About Product X.”

To set a navigation name:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Slide Properties.
3. Select a slide and click Edit.
4. In the Navigation Name text box, enter the text you want to use.
5. Click OK twice.

Setting a Go to Slide option

Presentations usually play linearly (slide 1, slide 2, and all the way through until the end). However, you can change the order by using the Go to Slide option. This enables you to skip slides in the presentation, without having to remove them. For example, if you set Go to Slide 8 after slide 5, your presentation will play until slide 5 and then jump to slide 8.

The Go to Slide option can be useful if you are creating one presentation that several audiences must use. For example, you can create a presentation about benefits options for full-time and part-time employees. When part-time employees view the presentation, they can skip slides containing information for full-time employees. The Go to Slide option works the same whether the presentation is used within Macromedia Breeze or viewed locally in a web browser.
To set Go to Slide options:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Slide Properties.
3. Select the slide that will be the starting point and click Edit.
4. In the Go to Slide pop-up menu, select the slide to which you want the presentation to jump.
5. Click OK twice to close all dialog boxes.

Adding video to a slide

You can include video files in a presentation, which appear in the viewer sidebar. This can be especially useful if you have a video of a speaker, sometimes called a “talking head” video. Breeze Presenter supports the Flash (SWF) and Flash Video (FLV) file formats. When video is added to a presentation, it appears in the location used for presenter photographs.

Note: Video is added individually to each slide. If you have one “talking head” video file that you need to use for multiple slides, split the video into separate files.

Video files added to presentations appear in the viewer where the presenter photograph is located.

To add video to a slide:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Slide Properties.
3. Select a slide and click Edit.
4. Next to the Video text box, click Browse.
5. Navigate to a SWF or FLV file, select the file, and click Open.

Note: If you select an FLV file and you publish the presentation to Breeze, the FLV file will also be hosted by Breeze. When a user views the presentation, the FLV file automatically streams. If you select a SWF file and publish the presentation to Breeze, the SWF file is delivered as part of the presentation.

6. Click OK twice to close all dialog boxes.

7. To test the file, preview the presentation. (For more information, see “Previewing a presentation” on page 14).

Setting slide advance behavior

By default, slides in a presentation advance automatically. You can, however, set individual slides to advance only when users click the Next button. This is useful if, for example, for a slide containing an interactive Captivate simulation that has no set duration time for the slide to play.

To set a slide so that users advance it:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Slide Properties.
3. Select a slide and click Edit.
4. Select Advance by User.
5. Click OK twice.

Adding and editing presenters

A presenter is the person who is providing the information in a presentation. For example, if the subject is software training, the likely presenter is an instructor, trainer, or product manager. A single presenter can be assigned to all slides in a presentation or different presenters can be assigned to individual slides.

You can provide users with valuable information about the presenter including the name, job title, a short biography, a logo, and contact information such as an e-mail address or phone number. This can make a presentation more credible, personal, and interesting. It also gives users the ability to ask follow-up or clarification questions.

Adding a new presenter profile

In Breeze Presenter, you add presenter profiles to one central location. These profiles are stored and can be used in any presentations you create.

To add a new presenter profile:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Select the Presenters tab.
4. Click Add.
5. Enter the name of the new presenter.
   *Note:* The Name text box is the only text box that you must fill in to create a new presenter.

6. (Optional) Enter a job title, such as Vice President.

7. (Optional) Next to the Photo text box, click Browse and navigate to an image file in JPEG or PNG format. After selecting an image file, the image appears in the Presenter Photo area on the right. (This is the exact size the image will appear in the presentation when it’s seen in the Breeze Presenter viewer.)
   *Note:* The recommended size for a presenter photo is 88 x 118 pixels.

8. (Optional) Next to the Logo text box, click Browse and navigate to a logo file in JPEG or PNG format. After selecting an image file, the image appears in the Logo preview on the right. (This is the exact size the logo will appear in the presentation when it’s displayed in the Breeze Presenter viewer.)
   *Note:* The recommended size for a logo is 148 x 52 pixels.

9. (Optional) Enter an e-mail address, such as jdoe@companyzyxwv.com.

10. (Optional) In the Biography text box, enter a short biography of the presenter, such as professional and educational credentials, length of time with company, a phone number, or job duties.

11. If you want to make this presenter the default presenter for all presentations, select the Default option.

12. Click OK.

13. Click Close.

**Setting the presenter for a slide**

You can set one presenter for an entire presentation or set different presenters for individual slides within a presentation.

**To set the presenter for an entire presentation:**

1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Slide Properties.
3. Click the first slide in the list.
4. Hold down Shift and click the last slide in the list. (Use the scroll bar on the right, if necessary, to navigate to the last slide in the list.)
5. Click Edit.
6. In the Presenter pop-up menu, select a name from the list.
7. Click OK.
   The presenter is now associated with all slides in the presentation.
8. Click OK to apply your changes and close the Slide Properties dialog box.
To set the presenter for an individual slide:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Slide Properties.
3. Select a slide and click Edit.
4. In the Presenter pop-up menu, select a name from the list.
5. Click OK.
   The presenter is now associated with the slide.
6. Click OK to apply your changes and close the Slide Properties dialog box.

Editing an existing presenter

After you have added a presenter, you can change presenter information, such as the job title, e-mail address, or biography, at any time.

To edit an existing presenter:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Select the Presenters tab.
4. Select a presenter from the list and click Edit.
5. Change properties such as the job title, e-mail address, or biography.
6. Click OK to close the Presenter dialog box.
7. Click Close to close the Breeze Presenter Preferences dialog box.

Deleting a presenter

You can delete a presenter and all corresponding information, such as the biography and e-mail address, at any time.

To delete a presenter:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Select the Presenters tab.
4. Select a presenter from the list and click Delete.
5. Click Close to close the Breeze Presenter Preferences dialog box.

Adding attachments to presentations

Attachments are files or URL links that you add to your presentation to provide users with supplemental information. Using attachments is a great way to take existing content, such as web pages, documents, PDF files, FlashPaper documents, Flash (SWF) files, or spreadsheets, and incorporate it into your presentation. You can also add links to websites or documents hosted by the Breeze Server or another third-party system.
Attachments are accessible to users when they view your presentation. An Attachments button appears on the bottom of the Breeze Presenter viewer. When the user clicks the Attachments button, a list of all of the attachments associated with the presentation is displayed. Users can click the individual attachment to open the file.

This example shows the Attachments window with several different types of attachments listed.

The following table lists common attachment types and what happens when a user clicks the file.

<table>
<thead>
<tr>
<th>Attachment type</th>
<th>Opens in</th>
</tr>
</thead>
<tbody>
<tr>
<td>FlashPaper</td>
<td>Default web browser, such as Internet Explorer or Mozilla Firefox</td>
</tr>
<tr>
<td>Microsoft Word document</td>
<td>Microsoft Word, if installed</td>
</tr>
<tr>
<td>Microsoft Excel spreadsheet</td>
<td>Microsoft Excel, if installed</td>
</tr>
<tr>
<td>Microsoft PowerPoint presentation</td>
<td>Microsoft PowerPoint</td>
</tr>
<tr>
<td>Text (TXT) file</td>
<td>Default text editor such as Notepad or Wordpad</td>
</tr>
<tr>
<td>PDF file</td>
<td>Adobe Acrobat Reader, if installed</td>
</tr>
<tr>
<td>Flash (SWF) file</td>
<td>Default web browser, such as Internet Explorer or Mozilla Firefox</td>
</tr>
<tr>
<td>Image or graphic file</td>
<td>Default web browser, such as Internet Explorer or Mozilla Firefox</td>
</tr>
<tr>
<td>URL link</td>
<td>Default web browser, such as Internet Explorer or Mozilla Firefox</td>
</tr>
</tbody>
</table>
To add an attachment to a presentation:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Presentation Settings.
3. Select the Attachments tab.
4. Click Add.
5. Enter a unique name for the attachment that will distinguish it from any other attachments you add.
6. In the Type pop-up menu, select File or Link.
7. If you selected Link in the Type pop-up menu, enter the full path of the link in the URL text box. If you selected File in the Type pop-up menu, click the Browse button to navigate to the file.
8. Click OK.
9. Continue adding attachments as needed and when you are finished, click OK.

Editing attachment information
After adding an attachment to a presentation, you can edit information about the attachment, such as the name and location, at any time.

Note: If you need to edit the attachment contents, open the file in the application in which it was created. For example, if the attachment is a spreadsheet created in Excel and you must change numbers in the spreadsheet, open the file in Excel and edit the numbers. After editing, add the attachment again in Breeze Presenter to incorporate the changes.

To edit a presentation attachment:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Presentation Settings.
3. Select the Attachments tab.
4. Select an attachment and click Edit.
5. Make any necessary changes to the name or location and click OK.
6. Click Close.

Deleting attachments
You can delete presentation attachments at any time.

To delete a presentation attachment:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Presentation Settings.
3. Select the Attachments tab.
4. Select an attachment and click Delete.
5. Click OK.
Using animation, image, and Flash (SWF) files

You can incorporate animations and Flash (SWF) files into your Breeze Presenter presentations. If you already have PowerPoint animations, such as flying or dissolving text, Breeze Presenter will convert those animations seamlessly and they will appear in your final presentation exactly as they appear in PowerPoint.

If you have SWF files containing animation, you can add those files to presentations. Simulations and demonstrations created with Macromedia Captivate are also in SWF file format and you can incorporate them into presentations easily.

Note: For additional information about adding video, see “Adding video to a slide” on page 20.

Synchronizing audio and animation timing

After previewing your presentation, you might want to edit the timing of PowerPoint animations to better synchronize with added audio files. For example, if you have a slide with bulleted text items that appear one by one, you can adjust the timing so that the audio track matches the action of the text.

To edit animation timings:

1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Synchronize Audio.
3. In the Synchronize Audio dialog box, click Previous or Next, if necessary, to navigate to the slide containing the audio and animation timing you want to edit.
4. Select Change Timings (the stopwatch icon) to play the audio.
5. As the audio plays, click Next Animation to set the timing for the first animation in coordination with the audio. Select Next Animation again to set the timing for the next animation. Repeat this step for all animations on the slide.
6. When you are finished, click Stop Editing.
7. Click OK.

Note: The Synchronize Audio dialog box only synchronizes PowerPoint "On mouse click" animations. In contrast, timed animations use the timing set in the Custom Animation dialog box in PowerPoint.

Adding pauses after animations play

If your presentation includes PowerPoint animations, you can have the presentation automatically pause after the animations play. This is useful if you want to clearly define where the animation ends and the presentation begins again.

To have the presentation pause after an animation plays:

1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Presentation Settings.
3. Click the Settings tab.
4. Select Pause After Each Animation.
5. Click OK.

When this option is selected, users must click the Play button in the toolbar to start the presentation again after a pause.

**Inserting Flash (SWF) files**

A Flash (SWF) file is a compiled, viewable-only Flash file that delivers graphics and animation over the Internet. You can insert SWF files directly into your presentations. You can use a SWF file for emphasis, such as an animated pointer, or to add more content to a presentation.

The following are tips for adding SWF files to presentations:

- Only SWF files published at 30 frames per second play properly.
- The SWF file you want to embed must not attempt to make any changes outside its own file. Therefore, the code cannot refer to the following variables: `_level#`, `_global`, or `stage`.

**To insert a SWF file into a presentation:**

1. In PowerPoint, open a presentation (PPT file).
2. Navigate to the slide to which you want to add the SWF file.
3. From the Breeze menu, select Insert Flash.
4. Navigate to the location of your SWF file. Select the SWF file and click Open.
   
   Breeze Presenter adds the SWF file to the slide.
5. (Optional) If necessary, select the file and drag it to a new location on the slide.

**Tip:** You can preview what the SWF file will look like by viewing the presentation in PowerPoint Slide Show mode. In PowerPoint, from the View menu, select Slide Show.

**Inserting Captivate files**

Macromedia Captivate is a software application that lets you create animated simulations and demonstrations. If you have Captivate projects, you can add them to your Breeze Presenter presentations.

Certain types of Captivate projects, such as training demonstrations or software simulations, can be particularly useful in presentations.

**To insert a Captivate demonstration or simulation into a presentation:**

1. In PowerPoint, open a presentation (PPT file).
2. Navigate to the slide to which you want to add the Captivate demonstration or simulation.
3. From the Breeze menu, select Insert Flash.
4. Navigate to the location of your Captivate simulation or demonstration SWF file. Select the SWF file and click Open.
   
   Breeze Presenter adds the Captivate demonstration or simulation SWF file to the slide.
5. (Optional) If necessary, select the file and drag it to a new location on the slide.
Controlling inserted SWF files

When you add a SWF file to a Breeze Presenter presentation, you can choose whether the added SWF file is controlled by the Breeze Presenter playbar or by a playbar in the original SWF file. For example, if you add a Macromedia Captivate demonstration SWF file to the presentation, the demonstration can be controlled by the Breeze Presenter playbar in the viewer or by the playbar that is in the Captivate demonstration.

To set how an inserted SWF file is controlled:
1. In PowerPoint, open a presentation (PPT file) containing an added SWF file.
2. From the Breeze menu, select Presentation Settings.
3. Click the Flash Files tab.
4. Select one of the Flash files in the list.
5. Do one of the following:
   ■ Select the Controlled by Presentation Playbar option. The selected Flash file will be controlled by the Breeze Presenter playbar when the published presentation is seen by users in the viewer.
   ■ Deselect the Controlled by Presentation Playbar option. The selected Flash file will play within the viewer, but cannot be controlled by the viewer playbar.
6. Click OK.

Setting image quality for a presentation

Setting image quality is a challenge of balancing quality and file size. If you set images to a higher quality, the presentation file size can become large. Setting images to a lower quality results in a smaller file size. You should test different settings to find the best compromise.

To set image quality:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Select the Quality tab.
4. Select an image-quality option:
   ■ High results in the largest file size and highest quality image.
   ■ Medium is the best balance between file size and image quality.
   ■ Low results in the smallest file size and lowest quality image.
5. (Optional) Select the Require Slides to Download Completely Before Playback option to require that all slides download before the presentation begins playing. This option is recommended if you think users might view your presentation on computers with slow connections speeds. If this option is enabled, it will take longer for the presentation to start, but the slides will play smoothly after the presentation begins.
6. Click Close.

Note: The Medium and Low options are useful in situations with extreme bandwidth limitations.
Macromedia Breeze Presenter lets you add narration, music, step-by-step instructions, or almost any sound to your projects. You can use audio to provide instructions or to emphasize key points in the presentation. In general, sound can be as individual and flexible as any other presentation component.

You can use audio in Breeze Presenter presentations in a variety of ways. For example, Breeze Presenter can help you with the following tasks:

• Adding sound to an individual slide
• Adding special sounds to quizzes for correct and incorrect answers

Breeze Presenter lets you record your own audio files (using some simple equipment) or import existing files. Imported files can be in WAV or MP3 format. (If you add a WAV file to a presentation, Breeze Presenter automatically converts the WAV file to MP3 format in the generated presentation.)

After you add audio to a presentation, you can synchronize the timing with other content, such as animations. For example, if your presentation contains PowerPoint animations such as text that “flies in,” you can synchronize the animations with the audio. (For more information, see “Using animation, image, and Flash (SWF) files” on page 26.) Breeze Presenter also contains features that enable you to add silent periods to audio files and to normalize audio for all slides so that the sound level is consistent.
Adding audio files to your presentation

You can quickly add WAV or MP3 format audio files to a presentation. Simply import the files and use them as opening music, narration, instructions, or for any other purposes.

**Note:** Breeze Presenter automatically converts imported WAV files to MP3 files.

**To add audio to a slide:**
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Import Audio.
3. Select the slide to which you want to add the audio file.
4. Click Browse and navigate to the audio file (WAV or MP3) you want to add to the slide.
5. Select the audio file and click Open.

Breeze Presenter adds the audio file to the selected slide. The name of the audio file appears in the File column and the length of the audio file appears in the Time column.

**Note:** You can add as many audio files as you want, but they cannot exceed more than 90 minutes of audio per slide in a presentation.

About audio recording equipment

Having the right audio equipment makes a big difference in the quality of recorded audio. Surprisingly, basic audio equipment can be relatively inexpensive; your equipment should include some if not all of the following:

**Computer with a sound card**  The sound card installed in your computer acts as a digital recorder for audio.

**Microphone**  If possible, you should avoid using the USB microphone packaged with your computer. Use a proper professional quality microphone cable and a stand to hold the microphone while you are recording.

**Microphone preamplifier**  A preamplifier boosts the signal of the microphone. The microphone input of your computer's sound card probably includes a preamplifier, but it's most likely a poor quality one. When purchasing a preamplifier, you can choose a small mixer or a stand-alone version. Mixers let you connect several microphones and devices to one location, and you can adjust their volumes independently. Stand-alone preamplifiers can be better than mixers at filtering out unwanted noises.

**Speakers**  The speakers that came with your computer are probably good enough for listening to any audio you record. However, if you are working on a laptop, you must use standard desktop computer speakers instead of the built-in laptop speakers.

In Microsoft Windows operating systems, you can usually find speaker (sound) settings by clicking Start in the lower-left corner and selecting Settings > Control Panel > Sounds.

**Headphones**  Headphones are important because when the microphone is on, speakers can cause distracting feedback. Additionally, it's best to use closed-ear headphones that prevent sound from leaking, which the microphone can pick up.
Recording software

A wide range of recording software is available. Important software features include editing capabilities (to fix mistakes), music and sound-effect options, and the capability to create the file format you require (such as MP3 or WAV). An excellent, easy-to-use, and free application is called Audacity (available from http://audacity.sourceforge.net).

Recording area

After you have acquired the necessary audio equipment, the most important action you can take before recording is an obvious one: Find a quiet place to record. Try closing doors, turning off any unnecessary computer equipment, turning off or lowering lights that might be making noise, turning off phone ringers, beepers, and pagers. Also, it helps to tell coworkers that recording is in progress.

About recording audio

You can follow these tips to ensure that you are recording the highest quality audio possible.

- “Setting up audio equipment” on page 31
- “Setting sound card options” on page 31
- “Changing audio recording settings” on page 31
- “Placing the microphone” on page 32
- “Improving microphone techniques” on page 32
- “Editing sound” on page 32
- “Reviewing the presentation” on page 32

Setting up audio equipment

When you have acquired the necessary audio recording equipment, you must set it up properly. First, plug the microphone into the mixer or stand-alone preamplifier, and then plug the output of that device into your computer sound card’s “line in.” Plug the headphones into your computer. Then, set the volume on the mixer or preamplifier. Begin speaking to test the volume levels, and carefully raise the volume until it shows just under zero.

Setting sound card options

You can open the software application that controls the sound card. (In most Windows operating systems, you can find sound settings by clicking Start in the lower-left corner and selecting Settings > Control Panel > Sounds.) When you select the recording source (line in), you can adjust the volume to 100%. If you are using a mixer or stand-alone preamplifier, the actual recording level can be controlled from there.

Changing audio recording settings

After starting your audio recording software, you can change the settings as necessary. Mixers and preamplifiers don’t have sound-level controls, so you rely on the meters when recording. While recording, you should ensure that you don’t exceed zero on the meters, or the sound will be distorted.
Placing the microphone

Positioning your microphone correctly can make a big difference in the finished audio file. First, get as close as possible to the microphone (within 4 to 6 inches) so that you avoid recording any other nearby sounds. Don't speak down to the microphone; instead, position it above your nose and pointed down at your mouth. Finally, you should position the microphone slightly to the side of your mouth, because this can help soften the sound of the letters *s* and *p*.

Improving microphone techniques

You should always have a glass of water nearby so you can avoid "dry mouth." Before recording, turn away from the microphone, take a deep breath, exhale, take another deep breath, open your mouth, turn back toward the microphone, and start speaking. This can eliminate breathing and lip-smacking sounds frequently recorded at the beginning of audio tracks. Speak slowly and carefully. You may feel that you are speaking artificially slowly, but you can adjust the speed later by using your audio recording software. Finally, keep in mind that you don't have to get everything right the first time. You can listen and evaluate each recording and re-record if necessary.

Editing sound

Editing sound is similar to editing text. You should listen carefully to your recording, delete any extraneous sounds, and then use the options available in your software to polish the sound. You can add any music or sound effects you require, but make sure to save your audio track in the correct format (MP3 or WAV files).

Reviewing the presentation

After you have added the audio to the presentation, listen to it again. You should view the presentation as users normally would. Finally, it helps to ask others to preview the presentation file. If necessary, you can edit the audio again, on a per-slides basis.

Setting audio recording quality

Audio files present the common challenge of balancing quality against size. The higher the sound quality, the larger the file size. The more you compress a sound and the lower the sampling rate, the smaller the file size and the lower the quality. Breeze Presenter lets you control the way sound is recorded and compressed based upon your input and output requirements.

Creating audio in Breeze Presenter is essentially a two-part process: you record audio in WAV format and then Breeze Presenter converts the WAV file into an MP3 file.

Of course, when working with audio, you must keep your users’ connection speed in mind. If a user is likely to access the Breeze Presenter presentation by using a dial-up modem, use a higher compression and lower sampling rate, such as 56 Kbps. However, if you are distributing the presentation on a CD-ROM, you can use a lower compression and higher sampling rate, such as 144 Kbps. In the best development case, you should experiment to find the optimal balance between sound quality and file size for your users.
To set audio recording quality:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Select the Quality tab.
4. In the Audio Options dialog box, set the following options:
   - **Input Source** specifies the type of recording device you are using to create audio. Select Microphone if you are using a microphone, or select Line in if you are using a different type of recording device.
   - **Audio Quality** specifies a quality level for the audio. Select an option in the pop-up menu. Remember that a higher quality level results in a larger audio file size.
   - **Calibrate Input** displays the Calibrate Microphone dialog box. It's important to calibrate your recording device for optimal sound quality.
5. When you finish recording, click OK.

Changing the audio input source

If you are recording audio for a presentation, you can either use a microphone or the line-in option that is usually included with an external audio device such as a tape deck or stereo amplifier.

To change the audio input source:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Select the Audio Source tab.
4. In the Audio Input Source area, select either Microphone or Line in.
5. (Optional) Select the Always Prompt to Set Microphone Level Before Recording option if you want to calibrate the microphone before each recording session. This is useful if you use different microphones or if you record in different environments (i.e., a quiet room versus an area with background noise).
6. Click Close.

Calibrating microphones for recording

If you are recording audio for a presentation, you must set the microphone or recording device to the correct recording level. This process is called calibrating the recording device. Breeze Presenter can detect optimal microphone and recording sensitivity levels automatically.

**Note:** Breeze Presenter must be able to detect a recording device before trying to calibrate. Check that a microphone or recording device (such as a tape deck or stereo amplifier) that uses the line-in option is connected to your computer properly and is turned on before calibrating.
To calibrate a microphone or recording device:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Record Audio.
   The Set Microphone Recording Level dialog box appears.
3. To set the correct recording device level, speak the following sentence into the microphone until
   the red recording window becomes green:
   “I am setting my microphone recording level for use with Breeze Presenter.”
4. When you finish, click OK.

Recording audio

If you have a microphone connected to your computer, you can record audio that you want to
include for a slide. You can use audio for many types of narration or instruction.

To record audio:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Record Audio.
3. Calibrate your microphone by following the instructions in the Set Microphone Recording
   Level dialog box.
4. Click OK.
5. Click Record Audio to begin recording.
6. Speak into the microphone or recording device.
7. When you finish, click Stop.
   Breeze Presenter converts the audio to MP3 format.
8. Click Play to listen to the recording.
9. (Optional) Click Previous or Next to record audio for another slide.
10. When you finish, click OK.

Importing slide notes

If you have created slide notes in PowerPoint, you can import the notes into the script window in
the Record Audio dialog box or the Synchronize Audio dialog box. This is useful if you want to
use the slide notes as a script when recording an audio file as voice-over narration.

To import slide notes into a presentation:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Record Audio or Synchronize Audio.
3. If necessary, select the View script option.
4. Click Import Notes.
5. Select the slide notes to import:
   - **Current Slide** imports notes from the slide that is currently displayed.
   - **All Slides** imports notes from all slides in the presentation.
   - **Slides** lets you to select specific individual slides in the presentation. To select multiple slides, hold down Shift or Control and select the slide numbers in the list.
6. Select the import options:
   - **Append Imported Notes to Current Scripts** adds any imported notes to the end of existing scripts.
   - **Replace Current Scripts with Imported Notes** removes any existing scripts before importing the notes selected on this dialog box.
7. Click OK.

**Exporting scripts into PowerPoint**

If you have created or modified a script in Breeze Presenter in the Record Audio dialog box or the Synchronize Audio dialog box to use while working with audio, you can export the script into PowerPoint. In PowerPoint, the script is imported and becomes slide notes.

**To export scripts into PowerPoint:**
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Record Audio or Synchronize Audio.
3. If necessary, select the View script option.
4. Click Export Script.
   - The Export Scripts dialog box appears.
5. Select the scripts to export. You can choose the current script, all scripts, or scripts on specific slides.
6. Select an export option. You can append scripts to existing PowerPoint notes (this adds script text to the end of any existing PowerPoint slide notes text) or replace existing PowerPoint notes with scripts (this deletes any existing PowerPoint slide notes text before adding the script text).
7. Click OK.

**Adding silence to an audio file**

You can add a period of silence to any audio file that is part of a Breeze Presenter presentation. This feature is particularly useful in the following situations:

- If you import an audio file and need to synchronize the audio with slides
- If you need to make an existing audio file work in a presentation without having to edit the audio extensively
- If you have inserted a Flash file with audio, such as a "talking head" video of a speaker, into a presentation and want to synchronize the Flash file audio with slides
To add a silence period to an audio file:

1. In PowerPoint, open a presentation (PPT file) containing audio files.
2. From the Breeze menu, select Audio Editor.
   The Audio Editor dialog box appears.
3. You can add silence anywhere in a presentation, including a specific location within an audio file. Click the location in the presentation, or the exact location within an audio file, on the waveform to which you want to add the silent period.
4. From the Insert menu, select Silence.
   The Insert Silence dialog box appears.
5. In the Insert text box, enter a number to specify the length of silence (in seconds).
6. In the pop-up menu to the right, select the position in the audio file to which you want to add the silence:
   - **Cursor Position (default)**: This option adds silence at the point in the waveform you selected in step 3.
   - **Start of Slide**: This option adds the silent period to the beginning of the slide containing the location selected in step 3.
   - **End of Slide**: This option adds the silent period to the end of the slide containing the location selected in step 3.
7. Click OK.
   Breeze Presenter adds the silent period to the audio file and displays it in waveform.
8. To test the audio file with the silence added, click Play in the lower-left corner of the Audio Editor dialog box.

Adjusting audio volume

You can adjust the volume of audio files included in your presentations. After adjusting the volume, preview the presentation to see if the sound level is acceptable.

To adjust the volume of audio files:

1. In PowerPoint, open a presentation (PPT file) containing audio files.
2. From the Breeze menu, select Audio Editor.
3. From the Tools menu, select Volume.
   The Adjust Volume dialog box appears.
4. Click the volume slider on the left side and drag it up to increase volume, or down to decrease volume.
5. You can change the audio processing options, as follows:
   - **Normalize**: allows Breeze Presenter to adjust the sound volume automatically. Normalizing audio helps keep the sound level consistent between slides.
   - **Dynamics**: amplifies quiet sections of the audio to help compensate for variations in audio volume.
6. (Optional) Click Advanced Controls.

**Ratio** specifies the maximum amplification that Breeze Presenter will use. The default setting of 2.0 sets the quietest sections of the audio to be amplified by a factor of 2. A higher setting can improve a project that has large disparities between quiet and loud sections, but can also amplify background noise.

**Noise Threshold** controls the amplification of background noise. Breeze Presenter doesn’t amplify any sound below the threshold. If background noise is amplified too much, it may help to set a higher noise threshold. (Note that the Dynamics option does not work well with high noise levels.)

7. When you finish, click OK twice to close all the dialog boxes.

**Editing audio files**

You can edit the audio in your presentation at any time. Using Audio Editor, you can listen to an audio file, insert silence, adjust volume, and change a number of other options.

To edit an audio file:

1. In PowerPoint, open a presentation (PPT file) containing audio files.
2. From the Breeze menu, select Audio Editor.
3. Use the buttons and menu options to make any necessary edits. You can cut and paste sections of the audio file, insert periods of silence to lengthen the audio file, adjust volume, import a different audio file, and more.

**Cut** lets you cut the selected portion of the audio file.

**Copy** lets you copy the selected portion of the audio file.
**Paste** lets you paste information from the Clipboard. (For example, if you select a section of the audio file, and then click Cut or Copy, Breeze Presenter places the selected audio on the Clipboard. You can then click Paste to place the audio back into any location within the audio file.)

**Delete** removes the selected portion of the audio file.

**Undo** lets you undo the previous action.

**Redo** lets you redo the previous action.

**Zoom In** enlarges the waveform.

**Zoom Out** shrinks the waveform.

**Record/Insert New Audio** begins recording audio. (You will need a microphone.)

**Play** starts the audio file.

**Pause** temporarily stops the slide from playing. (Click Play to resume playing the audio file.)

**Stop** ends playback of the audio file.

**Slide Number** specifies the slide selected in the waveform. For example, slide 4 or 12.

**Playhead** specifies the selected location, in seconds, within an individual slide on the waveform. For example, if you are working with a slide that is 5 seconds long and you click in the middle of the slide on the waveform, this playhead area displays approximately 00:00:02.500

**Selected** specifies the total playing time of the presentation, if no span of time is selected on the waveform. If you have selected a span of time on the waveform, this area displays the amount of time selected.

**Scale** specifies the scale at which the waveform is displayed. (To change the scale, click Zoom In or Zoom Out.)

4. When you finish editing the audio file, click OK.

**Using the Audio Editor**

Breeze Presenter lets you edit the timing of audio files after you record or import them. Having control over the timing of audio files gives you the ability to use audio files of different lengths and incorporate them smoothly into presentations.

After you record or import an audio file, the file appears as a waveform in the Audio Editor dialog box. If your presentation contains multiple audio files, you can see which audio files are assigned to specific slides.

**To edit audio timing:**

1. In PowerPoint, open a presentation (PPT file) containing audio files.
2. From the Breeze menu, select Audio Editor.

In the Audio Editor dialog box, Breeze Presenter displays any audio files incorporated into the presentation as waveforms. Slide numbers are shown along the top of the waveform so you can see exactly how the audio files are currently distributed across the slides. Breeze Presenter lets you import or create an audio file and then distribute that audio file across multiple slides.
To change how audio files are distributed across slides:
• In the Audio Editor, click a slide divider at the top of a red slide marker line and slide the divider to the left or right.

The waveform remains static, but you can change where the audio file begins to play within the presentation. This option is particularly useful if you have a long audio file and need to experiment with assigning the file to one slide or having it play over multiple slides.

To listen to an audio file:
• In the Audio Editor, click a location within the waveform and then click Play in the lower-left corner of the Audio Editor dialog box or press the spacebar on your keyboard.

The audio plays from the location you selected to the end of all audio in the presentation. (You can stop the playback at any time by clicking Stop in the lower-left corner of the Audio Editor dialog box or pressing the spacebar on your keyboard.)

To zoom in on a particular area of the waveform:
• In the Audio Editor, click the waveform and then click the Zoom In or Zoom Out icon in the toolbar. (Alternatively, click in the waveform and roll your mouse wheel to zoom in and out).

The scale at which you are viewing the waveform is shown in the Scale information box in the lower-right corner of the dialog box.

After you have added audio files to your presentation, you can use the Audio Editor to cut or copy entire audio files or portions of audio files and paste them in a new location.

To cut or copy and paste audio:
• In the Audio Editor, select a section of an audio file directly on the waveform, click Cut or Copy, click a different location on the waveform, and click Paste.

To delete an entire audio file or portion of an audio file:
• In the Audio Editor, select a section of an audio file directly on the waveform and click Delete.

To import an audio file into a presentation:
• In the Audio Editor, click a location within the waveform, select Insert Recording (lower-left corner), navigate to a file, and click Open.

The audio file is imported directly into the presentation in the location you specified.

Setting audio quality for a presentation

You can set the audio quality level for a presentation. Generally, you want to set the quality as high as possible within an acceptable file-size limitation. Because a higher quality results in a larger file size, you should experiment to achieve the correct balance between quality and file size. (The default setting is Medium.)

To set audio quality:
1. In PowerPoint, open a presentation (PPT file).
2. From the Breeze menu, select Preferences.
3. Select the Quality tab.
4. Under Audio quality, select one of the following options:
   - **High** results in the largest file size and highest quality audio.
   - **Medium** is the best balance between file size and audio quality.
   - **Low** results in the smallest file size and lowest audio quality.
   - **Publish Without Audio** removes audio files from the presentation before publishing.
5. Click Close.

**Previewing audio**

After you add an audio file to the presentation, you can preview the audio to test it. A quick way to listen to the audio is by viewing the slide show directly from within the Audio Editor.

**To preview audio:**
1. In PowerPoint, open a presentation (PPT file) containing audio files.
2. From the Breeze menu, select Audio Editor
3. From the View menu, select Slide Show.
4. When you finish, click Close.